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“Members Helping Members” 
(since 1983) 

Board of Directors 
2010-2011 

 
  Robin Seidenberg . . .. . . . . .. . . . President 
    president@lcace.org     
   
  Linda Busch . . . . . . . . . ... . ..Vice President 
    vicepresident@lcace.org 
 
  Bobby Jacobs. .  . . . . . . .. . . . . . . Secretary 
    secretary@lcace.org 
 
  Winnie Frost . .  . . . . . . . . . . . . . . Treasurer 
    treasurer@lcace.org  
 
  Julio Rivera  . . . . . . . . . . . . .. . . . Programs 
    programs@lcace.org 
 
  Lester Larkin . . . . . . . . . . . . . . Membership 
    membership@lcace.org 
 
  . .. .  . . . . . Public Relations 
   pr@lcace.org   
 

Volunteers 
 Webmaster ……………………. Lester Larkin 
   webmaster@lcace.org 
 
 Newsletter Editor …Dwight “J.J.” Johnson 
   editor@lcace.org 

The LCACE News Journal is published eleven 
times annually. Members are encouraged to 
submit contributions which will be acknowledged 
in this newsletter. 
 
Send articles to editor@lcace.org 
Permission is granted to reproduce any or all 
parts of this newsletter in other User Group 
publications, provided that credit is given to 
LCACE and the individual author(s).  
 
The News Journal is produced using a 
L.C.A.C.E  Logo designed on an Atari Stacy 
Laptop in 1989 by Dwight Johnson Jr. 

Lake County Area 
Computer Enthusiasts 

 
LCACE 

c/o Group Ambassador 
 

“J.J.” Johnson 
 

Membership 
Membership in LCACE is open to all individuals 
and families interested in personal computing. 
Annual dues are $20.00 per individual/family. 
Applications for membership may be obtained at 
the monthly meeting, by request on the club 
hotline, and are now available on our web site at  
- http://www.lcace.org. 

 
Meetings 

LCACE meetings are usually held on Saturdays 
at the Grayslake Area Public Library, 100 Library 
Lane, Grayslake, Illinois. The meeting room 
opens at noon and  the formal meeting begins at 
12:30 p.m.  All meetings are open to the public.  
Bring a friend! 

 
Newsletter Submissions 

Club members are welcome to submit classified 
ads, reviews, tips and other articles for 
publication, to our newsletter editor in Microsoft 
Word format (.doc). Publication deadline are 
the 20th of the month all ads, and articles. 
Please refrain from using tabs or special 
formatting.  

 
Newsletter Advertising 

Ad rates per issue: Full page - $25, Half page - 
$15, Quarter page - $10, Business Card - $5. 
Discounts are available on advance purchase of 
multiple issues. Please send camera-ready copy 
and payment to the club address by the 15st of 
the month preceding publication. For more 
information on ad pricing, please call our Hotline. 
Ads are FREE to all paid members. 
 

 Notice 
LCACE WILL NOT CONDONE  or knowingly 
participate in copyright infringement of  any kind. 
The LCACE News Journal is published by and 
for LCACE members. Opinions expressed herein 
are those of the individual authors and do not 
necessarily reflect the opinion of LCACE, the 
membership, the Board of Directors, and/or our 
advertisers. 
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Robin’s RAMblings 
 

F orty people welcomed Len Sacchitello, manager 
of Staples in Mundelein, and techs Mike Kaplan 

and James Thompson to our exciting March 12th meet-
ing.  J.J. prepared a PowerPoint agenda which everyone 
found very helpful.   
 
Len, James, and Mike discussed the latest in technology 
AND offered a free PC tune up to anyone who brought 
their computer to the meeting.  Staples staff arrived early 
and by noon were working on members' computers.  
Everyone liked the idea of techs working on their ma-
chines and getting them back right away.  James and 
Mike finished working on the last computers just before 
4 p.m.  Donna Kalinoski was a very happy camper when 
they made her "sick" PC well again. 
 
Staples PC Tune up removes adware and spyware, makes 
sure all security software is up to date, fixes missing 
items in the registry, optimizes your hard drive, gets rid 
of temp files and defrags your hard drive.  They also of-
fer PC Boost in the store which removes unneeded pro-
grams from the start up menu, makes the computer more 
efficient, and removes system services and extra toolbars 
that are not needed (There is a fee for this service.). 
 
Len, James, and Mike spoke about many areas of tech-
nology including cloud computing, RAID configurations, 
and anti-virus protection.  
 
Len strongly recommended purchasing external hard 
drives.  He said that when buying a hard drive, buy the 
largest you can afford.  You will eventually use the 
space, and it is cheaper per gigabyte to buy a larger drive 
than a small one.  Because USB 3.0 drives are being in-
troduced, Len said to watch for clearance prices on USB 
2.0 drives.  The advantage of USB 3.0 is that the data 
transfer rate is much faster than USB 2.0.  In theory, it 
will transfer 5GB per second.  USB 3.0 will work on 
USB 2.0 equipment (at USB 2.0 speeds) but you will 
need equipment that is USB 3.0 compatible to take ad-
vantage of the higher transfer speed. 
 

Everyone wants the people from Staples to come back to 
LCACE soon. 
 
Don Martin won $13.50 in our 50/50 drawing; treasurer 
Winnie Frost took home the door prize, a 4GB flash 
drive.  Phil Bock of Libertyville and Travis Whitlow of 
Mundelein joined LCACE.  Phil and Travis, welcome to 
LCACE!  Julie Bell brought Jordan almonds and organic 
popcorn and Liz Barnett brought a pan of her home made 
brownies.  Thank you to Julie and Liz for helping us stay 
well fed.  
 
We have exciting programs scheduled for 2011: 
 
April 2, 2011-Elections, club party, show and tell, ask the 
gurus 
 
May 14, 2011-Digital macro photography by Wendy 
Warden 
 
June 11, 2011-Online banking/internet security/identity 
theft-Detective Tim Warner, Grayslake Police Depart-
ment 
 
July 9, 2011-LCACE picnic at Liz and Fred Barnett's 
house 
 
August 13, 2011– TBA 
 
September 10, 2011– TBA 
 
LCACE has a three step election process. We take nomi-
nations for board positions in February, March, and 
April. We elect our board at the April meeting, and then 
choose our president from the people elected to serve on 
the board.  
 
Liz Barnett, Linda Busch, Winnie Frost, Bobby Jacobs, 
J.J. Johnson, Linda Koudelka, Lester Larkin, and Robin 
Seidenberg have accepted nominations. 
 
One way of protecting against identity theft is by check-
ing your credit report.  Go to 
www.annualcreditreport.com to get your free report.  
Sponsored by the three major credit bureaus, Equifax, 
TransUnion, and Experian, it is said to be the only gov-
ernment approved credit report site. 
 
Secunia Personal Software Inspector (PSI), http://
secunia.com/vulnerability_scanning/personal/, "is a 
FREE security tool designed to detect vulnerable and out

(Continued on page 4) 
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-dated programs and plug-ins which expose your PC to 
attacks.  It sounds like an interesting program. 
 
I heard that Maximum PC recently proclaimed that the 
three best security programs were Microsoft Security 
Essentials, Malwarebytes Anti-Malware, and SuperAn-
tiSpyware.  All three programs are free.  Cleaner is a 
free program that can be used to wipe your old drive 
free of data if you are giving it away.   
 
Storage prices are definitely dropping.  I recently saw a 
3TB USB 2.0/3.0 external drive for about the same 
price as the same company's USB 2.0 drive last fall.   
 

Happy computing! 

(Continued from page 3) 

Add Text on a Photo in Word 2007  
By Lynn Page, Editor, Crystal River Users Group, Florida 
December 2010 issue, CRUG newsletter 
www.crug.com 
newsletter (at) crug.com 
 
When creating a document it may be useful to place 
text with or on top of a photo. You could create a new 
photo with the text in a digital photo editing application 
and then save it for use. But if you will just use that 
image once why go to the bother. Within Word 2007 
you can add the text on top of your photo using either 
WordArt or a text box.  Which method to use depends 
on the effect desired. For text that is short and an inter-
esting stylized look is what you want WordArt is a 
good option. For plain and simple text a text box can 
match the text to that in the rest of the document.  
 
Text Box on Top of a Photo  
Placing a text box on a photo can be as easy as insert-
ing the photo, creating a text box and dragging the text 
box onto the photo. 
 

 
To add a photo to a document place the insertion point 
in the document where the photo is to be located and 
click the Picture icon in the Illustrations group on the  
Insert tab. Browse to the photo in the Insert Picture dia-
log box, select it and click the Insert button.  
 
To place a text box on the photo first create the text 
box. Place the insertion point on a line below the photo. 

Then in the Text group on the Insert tab, click text box 
and then click to select Simple Text Box. In the inserted 
Text Box type the text. To change the font or style of 
the text, highlight the text and then select the desired 
text formatting as with any other text. Drag the text box 
sizing handles to resize it as necessary. Finally click the 
outside edge of the text box and drag it to the proper 
location on top of the photo.   
 

 
The default Text Box will have white fill and a black 
border. For use over a photo you will probably want no 
fill color or border. With the Text Box still selected 
click Text Box Tools and on the Format tab, in the Text 
Box Styles group, click Shape Fill and select No Fill. 
Then click Shape Outline and select No Outline.   
 
With the Text Box you can add text on top of a photo 
and move the text to position it over the photo, but you 
can't rotate it. To be able to rotate the text or use text 
that is more stylized use WordArt.  
 
WordArt on Top of a Photo  
To place WordArt on the photo first create a Drawing 
Canvas. Place the insertion point in the document and 
then in the Illustrations group on the Insert tab open the 
Shapes drop down menu and click New Drawing Can-
vas.  
 

With the new drawing canvas still selected on the Insert 
tab, in the Illustrations group, click Picture. In the dialog 

(Continued on page 5) 



 5 

 

box browse to and select the photo to use and click the 
Insert button. Again on the Insert tab, but in the Text 
group, click WordArt, select the style desired, and type 
the text. Select either piece of art and use the sizing 
handles to resize as desired. Click the outside edge of 
the WordArt to select it and drag it over the photo. Use 
the rotation handle to rotate the text to the angle that 
works best for the photo.   
 
Once the graphics are correctly formatted and posi-
tioned group them. That creates a single graphic that 
can be moved or resized. The text stays with the photo. 
To create a group click the outside edge of the photo, 
press and hold the CTRL key, and click the edge of the 
WordArt so both items are selected. Under Drawing 
Tools, on the Format tab, in the Arrange group, click 
the arrow next to Group, and then click Group.   
 

 

(Continued from page 4) 

PC Tune-up 

50/50 Raffle 
Winner 

Don Martin 
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25 Years 
Dwight J.J. Johnson 
Lester Larkin 
Steve Kostelnik 
Mike McEnery 
 
15 Years 
Bob Berry 
 
10 Years 
Lesile Salsburg 
Jack Frost 

Winnie Frost 
Linda Busch 
Donna Kalinoski 
Terri Hanlon 
Gerald Straw 
Jay Bitterman 
Henry Henriksen 
Marshia Hobson 
 
5-Years 
Robin Seidenberg 
Lew Seidenberg 

Richard Garling 
Fred Barnett 
Patricia Ortseifen 
Liz Barnet 
Dorothy Sutherland 
Julio River 
Jack Haley 
Donald Martin 
Lois Berg-Wells 
Elizabeth Alleman 
Jean Anderson 
Edward Gothan 

CONTINUOUS MEMBERSHIP 
Our sincere CONGRATULATION to the following members who are celebrating continuous membership with Lake 
County Area Computer Enthusiasts. 

Time to renew  
your membership 
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 Liz Barnett 

 
 
 Bobby Jacobs 

 
 
 Linda Busch 

 
 
 Linda Koudelka  

Lester Larkin 

Winnie Frost 

Robin B. Seidenberg 

 
 
 
 

 
 

J.J. is the founder of L.C.A.C.E. Shortly after retiring 
from the US Navy, J.J. purchased his first Atari Com-
puter and with the help of Atari’s Users Group Pro-
gram, J.J. obtained the information needed to form the 
club in April of 1983. He has served as president and 
newsletter editor for the first two and a half years be-
fore the club established a board of directors, but con-
tinued to create the newsletter for an additional for 
twelve years. Over the past twenty-eight years, J.J. has 
worn several other hats which include:  treasure and 
two addition terms as president. As the clubs Digital 
Corner SIG leader, J.J. is sometimes referred to as “Mr. 
Gadget” whereby he seems to always surprises the club 
with his latest electronic toys. 
 
Although, J.J. retired from the Navy, he just changed 
his uniform to civilian clothes and for the past twenty-
eight years, he has continued to server the Navy at the 
Great Lake Naval Base as an Electrical School instruc-
tor, Computer Resource Center facilitator, Graphic De-
signer and presently as a Gunnery School classroom 
facilitator.  
 
J.J.’s  passion for photography lead him to forming 
Pegasus Photography where he enjoys event photog-
raphy and has contributed many hours photographing 
special events, and annual musical fundraisers around 
the Lake County area. 
 
His other pleasures are spent with friends and family 
enjoying musical theatre, and fine dining. As a joiner, 
J.J. is also a member of two other computer clubs and a 
camera club. J.J. is a true believer and sets an example 
of “Members Helping Members.”  

Dwight 
“J.J.” 

Johnson 
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 Liz Barnett 

 
 
 J.J. Johnson 

 
 
 Linda Busch 

 
 
 Linda Koudelka  

Lester Larkin 

Winnie Frost 

Robin B. Seidenberg 
 

Bobby  
Jacobs  

 
 
 
 
 
 
 
 
 
 
 
 
 

Bobby Jacobs has been a member of LCACE for about 
two years.  Before she was married to her husband, 
Howard, in 1960 Bobby was a computer programmer 
with Quaker Oats.  She used a Royal McBee computer 
which was very small for the time.  It was the size of a 
large desk. She and Howard have 3 children and 4 
grandsons.  In 1980 she bought a TRS-80 Model I.  
Since that time she has always had a computer to use.  
That Model I is the only one that she doesn’t still have.   
 
When she saw a genealogy program in a computer 
magazine, she typed the program in and began her 
computerized search for her genealogy.  She literally 
brought her TRS 80 III computer to Oak Terrace 
School every day, so the students could use a comput-
er like the other school in the district could.  She se-
lected the initial computers installed at the school and 
taught all students k-5 how to use the computers and 
sometimes write computer programs.   She also taught 
computer classes in summer school and to adults.  Af-
ter leaving Oak Terrace where she managed the com-
puter lab, she became a manager of The Software 
Tree, a new store in Hubbard Woods.  What was 
unique about the store at the time was that customers 
could try the software before they bought.  By the 
way, remember that old model I?  The first thing she 
did with it, was write a program to do payroll for 
Howard Displays.  Using two cassettes, the payroll 
took 2 ½ hours instead of 2 ½ days. Quite an achieve-
ment at the time!  Now she uses her computer for ge-
nealogy, keeping up with family and friends and other 
genealogists and keeping track of finances.  She loves 
to research and help others with their research. 
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Protecting Your Identity 

Tip of the Month 
 
STAY IN THE NOW: Consistently 
update your virus protection and anti-
hacker software. There are new viruses 

and technologies created all the time that can weaken 
your protection and make you vulnerable to criminals. 
 
DISARM AUTOMATIC LOGIN: Try to avoid using the 
Automatic Login feature that saves your name and 
password. Although it makes it easier for you to enter a 
site, it also makes it easier for hackers and criminals to 
obtain your personal information. 
 
WIPE IT CLEAN: If you’re disposing of your computer, 
make sure that you completely delete any personal 
information and also use a utility program that wipes 
(overwrites) the entire hard drive clean. 

WindowsTIPS 
by Bobby Jacobs 
Member LCACE 
 
Startup Defender 2.8– Startup Manager and Startup 
Firewall. Startup Defender is a small Windows startup 
manager program sold by Zards software for $19.95 that 
sits in your Windows tray and constantly monitors in real 
time the startup locations on your PC to help prevent pro-
grams from auto starting up behind your back. If a pro-
gram tries to write itself into any startup location Startup 
Defender will pop up a window and ask if the program is 
allowed to place itself to start automatically with Win-
dows.  I got this software for free from Giveaway of the 
day a couple of months ago.  There is also a similar one 

on CNET at http://download.cnet.com/Startup-
Defender/3000-2094_4-10822194.html , 
 
Another program that I like is Clear Cloud from Sunbelt 
Software.  http://www.clearclouddns.com/  This one was 
suggested by Steve Bass who writes for one of the major 
computer magazines.  ClearCloud is a free service that 
checks every website address your computer is trying to 
access, whether you're browsing the internet, clicking a link in 
an email, or a program "under the hood" trying to communi-
cate with servers for information or updates.  If you think it has 
stopped you from accessing a good site, you click on a link, 
add your email and are told by by the author why the site is 
being blocked.  If you can explain why it shouldn’t be blocked, 
he will unblock it. 

COMPUTERHUMOR 
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WORDTIPS 
Copying Values 
There are many ways that you can use Excel's tools to fill 
out various cells in a worksheet. One of the most com-
mon tools is to copy a cell (or cells) and then paste them 
into other cells. The only problem with this approach is 
that when you copy cells, you also copy the format of the 
original cells into the target cells. What if you just want to 
copy the values from the original cells, but retain the for-
matting already applied in the target cells? 

You probably already know that you can use the Paste 
Special option from the Home tab of the ribbon (Excel 
2007 and 2010) or the Edit menu (older versions of Ex-
cel), and then choose the Values option to paste just the 
values. If the target cells are right next to the original 
cells, there is an even easier way to accomplish the same 
task. Simply follow these steps: 

1. Select the original cells whose values you want 
to copy. 

2. Right-click on the fill handle (at the bottom 
right-corner of the selection) and drag the selec-
tion to encompass the target cells. When you 
release the mouse button, a Context menu ap-
pears. 

3. Choose the Fill Values option. Excel fills the 
target cells with the values from the original 
cells; the formatting remains unchanged. 

Inserting the User's Address 
Word automatically maintains several items of infor-
mation about you, as a user. One such item is your ad-
dress, which is changed on the User Information tab of 
the Options dialog box. If you want to automatically in-
sert the user address in your documents, you can follow 
these steps: 

1. Position the insertion point where you want the 
address inserted. 

2. Make sure the Insert tab of the ribbon is select-
ed. 

3. In the Text group, click Quick Parts. You’ll see 
a drop-down menu. 

4. Choose Field. Word displays the Field dialog 
box. 

5. In the Categories drop-down list, choose User 
Information. 

The Field dialog box. 

6. In the Field Names list choose UserAddress. 

7. Click on OK to close the dialog box and insert 
your field. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net. 
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Windows 7 has a new and improved version of 
System Restore that is far superior to the lame 
utility that came with XP.  Setting a restore point 
was often painfully slow, and it rarely worked as it 
should have. Windows 7 System Restore easily 
helps you bring back your computer's system files 
to an earlier point in time. It's a way to undo sys-
tem changes to your computer without affecting 
your personal files, such as e-mail, documents, or 
photos.   

 
Sometimes, the installation of a program or a driv-
er can cause an unexpected change to your com-
puter or cause Windows to behave unpredictably. 
Usually, uninstalling the program or driver corrects 
the problem. If uninstalling does not fix the prob-
lem, you can try restoring your computer's system 
to an earlier date when everything worked correct-
ly. 
 
System Restore uses a feature called System 
Protection to regularly create and save restore 
points on your computer. These restore points 
contain information about registry settings and 
other system information that Windows uses. You 
can also create restore points manually. 

APCUG PUSH Articles 
 

Understanding System Restore 
By Vinny La Bash, Regular Contributing Columnist, Sarasota PCUG, Inc., FL  
March 2011 issue, Sarasota PC Monitor 
www.spcug.org 
Vlabash (at) Comcast.net 

 
System Restore is not intended for backing up 
personal files, so it cannot help you recover a 
photograph or video that has been deleted or 
damaged. You should regularly back up your per-
sonal files and important data using a backup pro-
gram.  Windows 7 has an excellent built-in backup 
utility.   
 Windows 7 uses the Shadow Copy fea-
ture, introduced in Vista.  It’s vastly superior to the 
process in XP and earlier versions of Windows.  
The old way used a simple file filter and copied 
files around the system which was clumsy com-
pared to the Shadow Copy method.  Today, Win-
dows creates a snapshot of your drive which can 
later be used to restore your system should catas-
trophe occur.   
 
 Additional capabilities of Shadow copy in-
clude taking snapshots of files even when current-
ly in use.  Microsoft has incorporated this feature 
into Previous Versions which allows restoring a 
previous version of an application.  Unfortunately, 
this power is available only in Windows Profes-
sional or Ultimate.    
 
The easiest way to bring up System Restore is to 
type System in the Start menu search box and 
select it from the resulting list.  Another way is to 
select the Recovery option from Control Panel, or 
you can simply type rstrui in the search box.   
 
Whatever method you choose will bring up the 
System Restore dialog box that gives you some 
helpful information.  Select the Next button to get 
a list of restore points.  Most of the time you will 
be using the most recent restore point to get your 
system working again.   
 
Focus your attention on the Description list.  This 
can give you an important indication of what went 
wrong.  Did your problem begin after installing a 
Critical Update, a backup operation, or a new 

(Continued on page 12) 
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April Door Prize Question 
 
What new company was born when IBM sold its printer and Selectric divi-
sions? 

Robert Koudelka 
Jean Anderson 

Dwight “J.J.’’ Johnson 
Bobby Jacobs 

News 

Free Microsoft Office training manuals 

Learning how to use productivity software is cru-
cial to your success with a computer. But master-
ing software like Word and Excel can take years of 
practice. 
. 
The Mouse Training Company offers a long list of 
programs to train in. It has all of its training manu-
als available to download as PDFs  
 
User Manuals for Consumer Electronics 
Retrevo will store the manuals for all your gear 
and gadgets. We have over 100,000 manuals for 
you. Get Your Manual Now...  

Database Photos 
 
The follow members are requested to have their photos 
taken for the club at the next meeting they attend. 
Please see the membership chairperson to get your pho-
to taken. 
 
Barton, Berndtson 
Tracy Berry 
Phil Brock 
Roger Busch 
Richard Eisemann 
Robert Koudelka 
Carolyn Lewis 
Marta Mata-Guzman 
Cheryl Nickels 
Harriet Rodnit 
Kenneth Savage 
Ellen Smatlak 
Richard Wagner 

freeware program that you couldn’t resist?   
 
When you apply System Restore the system cre-
ates another restore point so you can undo the 
change if your problem isn’t fixed.  You can’t undo 
System Restore however, if you use it in safe 
mode.  But you can run System Restore again 
and select a different restore point.   
 
Restore points are saved until the disk space 
Windows allocates to the utility is used up.  Then 
the oldest restore points are deleted as new ones 
are needed.  The easiest way to delete all previ-
ous restore points is to turn System Restore off, 
and then turn it back on again.  Don’t worry about 
running out of space.   
 
Many computer problems can be traced to sloppy 
programs written by people who don’t know 
enough about proper programming techniques to 
get their utilities published by reliable vendors.  
It’s surprising how many problems are generated 
by faulty uninstall tools.  There are many sound 
freeware offerings out in cyberspace, but don’t use 
them unless they come tested and approved by a 
trusted source like Smart Computing.   : 
 

(Continued from page 11) 

Knowledge can be communi-
cation, but not wisdom. One 
can find it, live it, be fortified 
by it, do wonder through it, 

but one cannot communicate and teach it. 
 

HERMANN HESSE 
Siddhartha 

 

wisdom 
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Take a good 
look, you just 

might see  
yourself. 

http://lcace.org/PhotoAlbums.htm 

Have your Web Site Advertised here, 
e-mail me at editor@lcace.org 

 
www.pegasusphotos.zenfolio.com 

 
www.RobinSeidenberg.com  

 Members 

L.C.A.C.E.  
Phone: 847.623.3815 
Web Site: http://www.lcace.org 

 
 

Alleman, Elizabeth esa2204@aol.com 

Anderson, Jean jande77893@aol.com 

Barnett, Fred BNSCom@aol.com 

Becht, George pechmem-gen@yahoo.com 

Bell, Julie jmwebstuff@yahoo.com 

Berg-Wells, Lois luludefl@yahoo.com 

Berndtson, Barton bartb64@yahoo.com 

Berry, Bob & Tracy mgd2race@yahoo.com 

Bitterman, Jay bittjayl@aol.com 

Busch, Linda lindashrub@att.net 

D’Agostino, Robert rusirius2736@sbcglobal.net 

Ditman, Bill william.ditman@comcast.net 

Eisenmann, Richard eisenrich@sbcglobal.net 

Florian, Sherry florina3@earthlink.net 

Frost, Jack Jfrost13@sbcglobal.net 

Frost, Winnie wfrost13@sbcglobal.net 

Garling, Richard richgarling@yellobirdmktg.com 

Gothann, Edward eddiegothann@yahoo.com 

Halley, Jack jack96@aol.com 

Hamilton, Bill hamiltonbill24@comcast.net 

Hanlon, Terri terhanlon@comcast.net 

Henriksen, Henry hhenriksen@wi.rr.com 

Hesse, Gary pocanada@sbcglobal.net 

Hobson, Marshia omsgadget@yahoo.com 

Jacobs, Bobby bobj2361@gmail.com 

Johnson, Dwight jj1450xl@yahoo.com 

Kalinoski, Donna donnaleek@juno.com 

Kline, Cherie catmom1001@aol.com 

Kostelnik, Steve steve_kostelnik@usa.net 

Koudelka, Linda & Robert koudelka3@comcast.net 

Kusiak, Joseph juj014@att.net 

Lagoni, Doreen bearmagic1999@aol.com 

Larkin, Lester LesLarkin@aim.com 

Lewis, Carolyn lewis.linwood@att.net 

Martin, Donald dmartin339@comcast.net 

Mata-Guzman, Marta marta5131959@yahoo.com 

McEnery, John bigjohn1@optonline.net 

McEnery, Mike mmcenery@sbcglobal.net 

Nickels, Cheryl cnickels1110@yahoo.com 

Nocerino, Phil windpiper2@yahoo.com 

Ortseifen, Patricia patricia@ortseifen.com 

Rehberger, Eric graduates63@gmail.com 

Rivera, Julio jlrivera@db3mail.com 

Salsburg, Leslie leslie164@juno.com 

Savage, Danjean & Ken kennethisavage@hotmail.com 

Seidenberg, Lew drlew1@aol.com 

Seidenberg, Robin anguslechat@aol.com 

Smatlak, Ellen emsmis@hotmail.com 

Straw, Gerald gkstraw@comcast.net 

Sturek, Jorja jksturek@sbcglobal.net 

Sutherland, Dorothy deedee1938@yahoo.com 

Urh, John johnurh@sbcglobal.net 

Wagner, Richard & Belinda SenoritaBW@AOL.com 

Wells, Alden alden_racing74@yahoo.com 

Rudnit, Harriet hrudnit@yahoo.com 
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How Do I...??? 
What can I do...? 
Where is the...? 
Why can’t I...? 
 

So you got a new toy for the holidays and 
can’t figure out  how it works. Well bring your 
question and your new toy to the January 
meeting and ask our gurus.  
 
The gurus can help you get up to speed with 
your new toy, computer, camera or software.  

April	

2	

Saturday 

Next  
Meeting 

Meeting Agenda: www.lcace.org 
 

Meeting 
Agenda 

 
 

 
 
 
 
 
 
 

 
 
 

Linda has been a member of LCACE since 1998. She 
has served as President (2001-2004), Secretary, and 
Membership chairperson. Linda’s hometown is Liber-
tyville but presently resides in Round Lake with her 
husband Roger. She is presently retired after working as 
a secretary on the naval base for over 25-years.  
 
Linda’s  extended family stretches off the page, there-
fore, we will just say she is married, and her parents, 
siblings, children and grandkids live in the area. She is 
a game fanatics, you name it and Linda loves to play it, 
and has recently purchase a Wii game consel the enjoy 
the electronic version of her most loved games (i.e. 
Scrabble), and she also enjoys reading catacomb of 
magazines (especially in waiting rooms).  
 
She will tell you her favorite food is Chicken Fettuccini 
Alfredo, but some of us personally know she likes eggs 
at any hour of the day.  Linda’s prize passion is her 
family and friends, especially her grandkids. And with-
out saying, she admires her father the most (WWII sur-
vivor). Like many of us, she wishes she could stop pro-
crastinating, but don’t we all. For those of us who know 
her the best, she wants to be remembered with a smile 
on her face and guessing what she’s been up to?  
Of course there’s a computer in her life and she mainly 
uses it for photos, documents, spreadsheet (boring) and 
games (yeah). Her favorite computer program is: “the 
one I’m using when you ask me that question.” And her 
favorite expression is “ROGER.” 

Linda 
Busch 

Members 

Profile 
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